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1. Introduction

1.1. About the Application

IP2Archive Deep Archive Controller is an automated application or robot that picks up the
archive, restore and purge requests originating from Deep ArchiveManager. It will assign
these requests to an available hierarchical storagemanagement system and request to
initiate the archive, restore and purge process. It will check the progress and status of the
archive, restore and purge processes and also synchronize the status of the hi-res video
files in the IPDirector database with the status in the IP2Archive database. Once a hi-res
video file has been archived, and the operator has requested in the Deep ArchiveManager
to remove it from the nearline storage, the Deep Archive Controller will remove the
corresponding entry from the IPDirector database and delete the hi-res video file from the
nearline storage.
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2. Starting the Application

2.1. Start-up Procedure

2.1.1. After Installation

Double-click the IP2Archive Deep Archive Controller icon on the desktop of the
application server to start the application. You can also start the application by double-
clicking the executable file (.exe) in the installation folder.

The splash screen appears.

The application logs into the database. Then, the Settings window appears allowing you to
configure the application.

See section "Settings Window" on page 7.

2.1.2. After Configuration

Double-click the IP2Archive Deep Archive Controller icon on the desktop of the
application server to start the application. You can also start the application by double-
clicking the executable file (.exe) in the installation folder.

The splash screen appears. The application logs into the database.

Then, themain window opens. After a time interval defined in the settings, the application
automatically starts performing its various tasks.
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2.2. Main Window Overview

Themajor areas of themain window are highlighted in the screenshot below.

(1) Menu Bar

Themenu bar contains threemenus: File, Settings and Help.

The File menu contains only one command: Exit. It is used to exit the application. Click
the File menu or use the keyboard shortcut keys ALT + F or F10 + F to open it. Click Exit
or use the keyboard shortcut key X to exit the application.

The Settings menu doesn’t contain any commands. It immediately gives access to the
application settings. Click the Settings menu or use the keyboard shortcut keys ALT + S
or F10 + S to access the settings.

The Help menu contains only one command: About. With this command the application
splash screen can be opened. The splash screen displays the application software
version, the name of the database the application is logged on to and the login name used.
Click the Help menu or use the keyboard shortcut keys ALT + H or F10 + H to open it.
Click About or use the keyboard shortcut key A to open the splash screen.

Thesemenus only become available after you have clicked the Stop button.

(2) Tasks Pane

The Tasks pane displays the number, name and description of the tasks performed by the
application. Only the tasks that were activated in the System settings will be performed at
start-up. If you want to manually run certain tasks for test purposes, you have to stop the
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application, select the corresponding check box in the Active column, and then click the
Start button. This button only becomes available after you have clicked the Stop button.

See section "Tasks Tab" on page 16.

(3) Start/Stop Buttons

These buttons are used tomanually start and stop the application.

(4) Log Pane

The Log pane lists application events and can be useful when you are trying to verify that
automations are working correctly. The date and time of each event is displayed.
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2.3. Overview Tasks

The table below gives a brief description of the tasks performed by Deep Archive
Controller.

Number Task Description

1 Assign
Archive
Storage

Interfacing With DIVA/XenData
Checks the IP2Archive database for an available deep
archive system. It assigns the available system to the
archive request.

2 Start
Archive

Interfacing With DIVA
Requests IP2Archive Tape Storage Controller to start the
archive process.
Interfacing With XenData
Requests File Transfer Daemon to copy one or more hi-res
video files and their metadata XMLs from the nearline storage
to the XenData server.

3 Check
Archive

Interfacing With DIVA
Checks the progress and status of the archive process in the
IP2Archive database.
Interfacing With XenData
Checks the progress of the transfer of the hi-res video files
and their metadata XMLs from the nearline storage to the
XenData server.

4 Assign
Restore
Storage

Interfacing With DIVA/XenData
Checks the IP2Archive database for an available deep
archive system. It assigns the available system to the
restore request.

5 Start
Restore

Interfacing With DIVA
Requests IP2Archive Tape Storage Controller to start the
restore process.
Interfacing With XenData
Commands File Transfer Daemon to request XenData to
restore one or more files. It then copies the restored files to
the nearline storage.

6 Check
Restore

Interfacing With DIVA
Checks the progress and status of the restore process in the
IP2Archive database.
Interfacing With XenData
Checks the progress of the transfer of the hi-res video files
and their metadata XMLs from the XenData server to the
nearline storage.

7 Synchronize
Hires

Interfacing With DIVA/XenData
Synchronizes the status of the hi-res source files in the
IPDirector database with the status in the IP2Archive
database.
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Number Task Description

8 Remove
Hires

Interfacing With DIVA/XenData
Checks in the IPDirector database if the lo-res video file is
available on the nearline storage.

If the lo-res video file is available, then IP2Archive Deep
Archive Controller will command IPDirector through the
IPDirector API to remove the hi-res video file from the
nearline storage. It also commands IPDirector to remove the
hi-res video file entry from the IPDirector database.

10 Retrieve
Tape IDs

Interfacing With DIVA
Not applicable.
Interfacing With XenData
Requests Tape Storage Controller to retrieve the LTO tape
IDs via the XenData or ADA API.

11 Start Purge Interfacing With DIVA
Requests IP2Archive Tape Storage Controller to start the
purge process.
Interfacing With XenData
Commands File Transfer Daemon to request XenData to
purge one or more files.

12 Check
Purge

Interfacing with DIVA/XenData
Checks the progress and status of the purge process in the
IP2Archive database.

Note
For performance reasons, two or more instances of the Deep Archive Controller
can be installed. Each instance can be configured to perform only a specific set
of the tasks mentioned above. For example, there could be an instance that only
performs the archive and purge tasks, and an instance that only performs the
restore tasks.

6 2. Starting the Application

EVSBroadcast Equipment S.A. - October 2012 Issue 2.2.D



3. Configuring the Application

3.1. Settings Window

3.1.1. Opening the Settings Window
The Settings window allows you to configure your application. The first time the
application is launched after it has been installed, the Settings window opens
automatically.

The Settings window can also be accessed through the Settings menu. Tomake this
menu available, click the Stop button. The application will stop performing its tasks.

3.1.2. Overview Setup Categories
The settings can be divided into three setup categories. In the Settings window, a tab is
provided for each setup category. The table below briefly describes each setup category:
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Setup Category Description

User Settings These settings can be configured by each individual user.

Global Settings These settings can only be configured by the system
administrator and by an eventual superuser.

System Settings These settings configure the general functioning of the
application. They can only be configured by the system
administrator.

Currently, only the User Settings and System Settings tab contain settings. TheGlobal
Settings tab is still empty. It does not contain any settings.

3.1.3. Edit Mode
To be able to edit the Global and System settings, you first have to enter a password.

To put the Settings window into Edit Mode, proceed as follows:

1. Click the Enter Into Edit Mode button .

A dialog box appears.

2. Enter the administrator password and then click OK.

The Settings window enters into Edit Mode.

3.2. User Settings

3.2.1. Accessing the User Settings
The User settings can be accessed by clicking the User Settings tab in the Settings
window.

3.2.2. Overview User Settings Subcategories
The User settings are divided into the following subcategories:

• MAD

For each subcategory a tab is provided.
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3.3. System Settings

3.3.1. Accessing the System Settings
The System settings can be accessed by clicking the System Settings tab in the Settings
window.

3.3.2. Overview System Settings Subcategories
The System settings are divided into the following subcategories:

• Directories

• MAD Options

• Oracle Connection

• E-Mail Options

• Timers

• Tasks

• Global Password

• Error Handling

• IPDirector

For each subcategory a tab is provided. The Directories tab is empty. It doesn't contain
any settings.

3.3.3. MAD Options Tab
TheMAD Options tab contains divers settings.
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Connect with IPDirector

Deep Archive Controller forms part of IP2Archive and communicates with IPDirector via
the IPDirector API. It can also be used independently, i.e. in archive solutions without
IPDirector. Then, communication with IPDirector is not necessary.

Clear the Connect With IPDirector check box if Deep Archive Controller doesn’t have to
communicate with IPDirector. The IPDirector tab will become unavailable.

Select the Connect With IPDirector check box if Deep Archive Controller has to
communicate with IPDirector.

Defining Set ID

In the Tape Storage group box you have to enter the default tape set ID as defined in the
DIVArchive. Each LTO tape belongs to a particular set. Each set has a particular ID. This
setting only applies if IP2Archive interfaces with DIVA.

Remote Storage

IP2Archive can interface with various archive systems. In case it interfaces with
XenData, the archiving of a file happens by copying this file from the nearline storage to
the XenData storage. The copying is performed by the File Transfer Daemon application.
In the Application field you have to select the name of the File Transfer Daemon that
Deep Archive Controller has to control.
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If IP2Archive interfaces with an archive system other than DIVA, Deep Archive Controller
has to try to retrieve the ID of the LTO tape from the archive system once the archiving of
particular files on this tape has been completed. It will request Tape Storage Controller to
retrieve this ID through the Hierachical StorageManagement system API. Select the
corresponding check box.

Removing Hires

In the Remove Hires group box two checks can be enabled or disabled. The first check
will verify if the low-resolution video file of a particular clip exists on the nearline storage
before removing the corresponding high-resolution video file from the nearline storage. If
the low-resolution video file does not exist, an error message will appear in the Log pane of
Deep Archive Controller and also in the Archived tab of the Deep ArchiveManager. If this
check is not enabled, Deep Archive Controller will not verify the existence of a low-
resolution video file.

The second check will verify if the low-resolution video file on the nearline storage is
actually stable. A time interval can be set (in seconds) after which Deep Archive
Controller has to consider a low-resolution video file to be stable. As long as the low-
resolution file is not stable, the high-resolution video file cannot be removed.

If the VarID of the low-resolution video file differs from the VarID of the high-resolution
video file, Deep Archive Controller won't be able to find the low-resolution video file, and
thus will not allow the high-resolution video file to be archived. If the option To Find Lores
Using AssetGUID If It Cannot Be Found Using VarID is selected, Deep Archive
Controller will check if it can find the low-resolution video file by means of the AssetGUID
of the clip the high-resolution video file it belongs to. If it can find the low-resolution video
file, it will change its VarID into the VarID of the high-resolution video file.

Configuring Log File Management

To be able to configure the log file management, you have to select the Log Files check
box.

In the Directory field you can enter the path of the log storage directory or you can browse
for it by clicking . If you leave this field empty, the application will automatically create
a default directory: C:\EVSLogs\MAD\[Application name].

If the A New Log Every Day check box is selected, a new log is started every day.

You can also specify a time interval (in days) after which the logs should be removed from
the log storage directory. If you enter ‘-1’, the logs are never removed from the storage
directory.

Configuring LogMemo Size

In the LogMemo group box you can specify themaximum number of lines retained by the
Log pane.
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3.3.4. Oracle Connection Tab
TheOracle Connection tab allows you to configure the connection with the Oracle
database.

Entering the Database Name

In this field you have to enter the name of the database the application has to connect to.

If the Use This Database Name check box is selected, the name of the database will
automatically appear in the Oracle login dialog box at start-up.

Entering the Login Name

In this field you have to enter a login name. If the Use This Login Name check box is
selected, the login namewill automatically appear in the Oracle login dialog box at start-
up.

Entering a Password

In this field you have to enter a password. If the Use Auto Login check box is selected,
the application automatically logs into the selected database at start-up. TheOracle login
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dialog box does not appear.

Activating Version Control

If the Use Version Control check box is selected, the software version of the application
is checked each time it logs into the database. This check box should always be
selected!!

If the software version is outdated, the following warningmessage appears in the splash
screen highlighted in red: ‘Obsolete – A newer version exists. May not be used anymore.’

Click the OK button to close the splash screen and update your software version.

By clicking the Application History button, you can open a chronological list of all
software versions of the application. To get more details about each version (creation
date, name of programmer, status, additional remarks), you have to click + next to the
version number.

Activating Keep Alive

If the option Keep Connection Alive is selected, amessage is sent to the database at
regular time intervals to avoid idle connections from being closed by the firewall. These
intervals can be set by you.

If the option Try to Reconnect if Keep Alive Fails is selected, the application will try a
number of times to reconnect with the database.

If the option Report Status in Database Everytime Keep Alive Timer Triggers is
selected, the status of the connection is reported in the database each time the Keep
Alive Timer sends a trigger to send a Keep Connection Alivemessage.

If the option Report Status of Tasks is selected, the status of the tasks (ok or not ok) is
reported to the database.

Testing the Oracle Connection

The Test Oracle button allows you to check the validity of the database name, login and
username you entered.

If these data are valid, then the followingmessage appears next to the Test Oracle
button: ‘OK’.

If the login name or password is invalid, then amessage box appears with the following
message: ‘ORA-01017: invalid username/password; logon denied’.

If the database name is invalid, then amessage box appears with the followingmessage:
‘ORA-12154:TNS: could not resolve the connect identifier specified’.

If you omit the password, then amessage box appears with the followingmessage:
‘ORA-01005: null password given; logon denied’.

If you don’t enter a database name, login and username, then amessage box appears
with the followingmessage: ‘ORA-12560: TNS: protocol adapter error’.

If the Use Version Control check box is selected, you can also check the software
version of the application by clicking the Test Oracle button. If the software version is up-
to-date, then the followingmessage appears: ‘Actual – The Actual Version’. If the software
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version is outdated, then the followingmessage appears: ‘Unknown Version Application!
Please contact the EDP department.’

If you close the Settings window without testing the validity of the database name, login
and username you just entered, then amessage box appears.

If you click Yes, then the Settings window is closed and the original values are restored. If
you click Cancel, then the Settings window doesn’t close and you can test the values by
clicking the Test Oracle button.

If you change the current database settings, test the connection and then close the
Settings window, amessage box will appear.

If you click Yes, the application is stopped and closed. A manual restart will be required.
Click Cancel to continue.

3.3.5. E-Mail Options Tab
The E-Mail Options tab allows you to configure an e-mail account enabling the application
to e-mail error notifications to the EVS developers.
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EVSBroadcast Equipment S.A. - October 2012 Issue 2.2.D



To be able to configure the e-mail account, you have to select the Send E-Mail check
box. The fields in theMail System Settings andMail Message Settings group box become
available.

Configuring an E-Mail Account

In theMail System Settings group box you have to enter the IP address and port number
of the SMTP server and specify a timeout. In the SMTP Login group box you can enter a
username and password.

Configuring a Default E-Mail Message

TheMail Message Settings group box contains two tabs: Internal Mail Settings and
External Mail Settings.

The Internal Mail Settings tab is used to configure a default e-mail message that will be
sent to the EVS developers when an error occurs.

The External Mail Settings tab is used to configure a default e-mail message that will be
sent to the customer to notify him about an error. In each tab you have to enter the
sender’s email address, the email address of the various recipients and a subject.

To test the settings andmanually send an e-mail message, click the Send Mail button.
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3.3.6. Timers Tab
The Timers tab allows you to set time intervals for some automated tasks.

Configuring Auto-Start

In the Auto Start group box you can specify the time interval after which the application
automatically starts performing its tasks.

Setting Time Interval Between Tasks

In the Perform Tasks group box you can specify the length of the time interval (in
seconds) between two subsequent tasks.

3.3.7. Tasks Tab
The Tasks tab gives an overview of the active tasks.

In the Active by Default column you can activate the tasks that must be performed by
default at start-up. The Active column displays the tasks that are currently selected in the
main window. By default, all tasks are selected in both columns.
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3.3.8. Global Password Tab
TheGlobal Password tab allows you to set a password that the superuser(s) has/have to
enter to be able to edit the Global settings of the application, if any. To apply the
password, you have to click the Apply button.

3.3.9. Error Handling Tab
The Error Handling tab is used to configure the error handling by the application. This tab
will only be used by the EVS administrator.

Handling Unhandled Errors

If the Save the Screen Dump check box is selected, a screenshot is taken of an
unhandled error message and stored in the database and in a folder on the computer
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where the application is installed. In the Not Logged Error(s) pane, errors can be typed for
which no log was created. By default, this check box is selected.

Handling Handled Errors

If the Save the Unforced Error Log’s check box is selected, the log of the error is saved
in the database and in a folder on the computer where the application is installed. By
default, this check box is selected.

If the Save the Screendump check box is selected, a screenshot is taken of the error
message and stored in the database and saved in the same folder as where the error log is
kept. By default, this check box is selected.
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3.3.10. IPDirector Tab
Deep Archive Controller communicates with IPDirector through the IPDirector API. The
IPDirector tab allows you to configure this communication.

Configuring Connection With IPDirector API

In the IPDirector API Settings group box you have to enter the data Deep Archive
Controller needs to be able to communicate with the IPDirector API:

• IP address or hostname of the server that hosts the IPDirector API.

• Login, i.e. ‘administrator’ and password, i.e. ‘evs’, necessary to log into the IPDirector
API.

The path to the IPDirector API .wsdl file is automatically calculated on the basis of the IP
address of the server that hosts the IPDirector API.

You can set a default command timeout interval.

You can also set a default time interval after which the token of a session is reset.

A Test button is provided allowing you to test the login and username. If all data is correct,
themessage ‘Connected’ will appear. Otherwise, themessage ‘Not Connected’ will
appear.

To enable extended logging of the SOAP client, select the corresponding setting.

To enable tracing of the communication between the SOAP client and server, select the
corresponding setting.

Retrieving New IPDirector Metadata After Restore

The Retrieve New IPDirector Metadata After Restore group box contains settings related
to the hi-res and lo-res metadata XML files. Select the corresponding check box to
activate them.
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Deep Archive Controller makes a copy of the hi-res metadata XML before archiving and
renames it (.ip2a). The copy gets archived, and then Deep Archive Controller removes
both the original hi-res metadata XML and the copy from the nearline storage. When the hi-
res video file and hi-res metadata XML get restored, Deep Archive Controller will create a
copy of the lo-res metadata XML file. It will copy the <General Info> part of the restored hi-
res metadata XML and paste it in the copy of the lo-res metadata XML. Since the restored
hi-res metadata XML doesn’t contain themost recent metadata (logs, keywords, bin,
archivemetadata) the copy of the lo-res XMLwill be used to create an updated hi-res
metadata XML. Deep Archive Controller will also change the value <AssetItemMode> in
the copy of the lo-res metadata XML.

When part of a hi-res video file gets restored, Deep Archive Controller will create a copy of
the lo-res metadata XML of the source clip, change the video format of this copy and add
the TC In and TC Out of the subclip and the VarID of the subclip.

In the Original Metadata File Extension field, enter the file extension of the original hi-
res metadata XML. In the Temporary Metadata File Extension field, enter the file
extension of the copy of the hi-res metadata XML.

The hi-res and lo-res metadata XML have the tag <AssetItemMode>. Themetadata value
held by this tag indicates if themetadata XML file refers to a lo-res (= 1) or hi-res video file
(= 0). When replacing specific metadata parts of the copy of the lo-res metadata XMLwith
the correspondingmetadata parts of the hi-res metadata XML, the value in this tag will get
the value of the hi-res metadata XML, i.e. 0. In the AssetItemMode field, enter the value
that Deep Archive Controller should restore in the tag <AssetItemMode> after it has
replaced themetadata parts.

If the option Report Error If Lores File Is Not Available is selected, Deep Archive
Controller will give an error if a user tries to restore a clip of which the lo-res video file is
not available on the nearline storage. If this option is not selected, no error will be given,
but the restored hi-res metadata XML, which doesn’t contain themost recent metadata,
will be used to create the lo-res metadata XML.

Select the check box Clear AssetItem GUID. In the hi-res metadata XMLDeep Archive
Controller will clear the asset item guid value that was copied from the lo-res metadata
XML. This should be automatically generated by IPDirector.

Select the Remove Before Archiving check box if the copy of the hi-res metadata XML
has to be removed from the nearline storage.

Note
This tab becomes unavailable if the setting Connect with IPDirector is cleared in
theMAD Options tab.
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